
WIRELESS LAN SWITCH MANAGER (3WXM) 
VERSION 4.0.18 RELEASE NOTES
Related Documentation
Please use these notes in conjunction with the following 
documents:

■ Wireless LAN Switch Manager User’s Guide

■ Wireless LAN Switch Manager Reference Manual

You can obtain the latest technical information for this 
product, including a list of known problems and solu-
tions, from the 3Com Knowledgebase:

http://knowledgebase.3com.com

Software License Agreement
Before you use the 3WXM software, please ensure that 
you read the license agreement text. You can find the 
license.txt file on the CD-ROM that accompanies your 
product, or in the self-extracting exe that you have 
downloaded from the 3Com Web site.

What's New in 3WXM Version 4.0.18
3WXM Version 4.0 contains the following:

■ Support for external MAP antennas

■ Support for 120 Active MAPs on a WX4400

Support for External Map Antennas

3WXM Version 4.0.18 adds support for the following 
external antennas.

You can use 3WXM to configure a new or existing MAP 
to use one of these antennas. 

External antennas can be used on any MAP supported 
by the MSS. However, antenna model ANT3C598 is not 
supported on MAP model AP2750.

All MAP radios use their internal antennas by default. To 
configure a MAP radio to use an external antenna 
instead, use the Modify MAP wizard. (See the “To 

Antenna Model Description

ANT3C591 High-gain omnidirectional

ANT3C592 Ceiling

ANT3C597 Hallway

ANT3C598 Panel
Part No. DNA-WXM10-AAA01
Published January 2006

http://knowledgebase.3com.com
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modify radio settings” section of the “Configuring 
Wireless Parameters” chapter in the Wireless LAN 
Switch Manager Reference Manual.)

Support for 120 Active MAPs on a WX4400

MSS Version 4.0.21 increases the maximum number 
of MAPs a WX4400 switch can boot and manage. In 
previous MSS versions, a WX4400 could boot and 
manage up to 96 MAPs. In MSS Version 4.0.21, a 
WX4400 can boot and manage up to 120 MAPs. 
3WXM supports this change. 

To use the increased MAP support, you must use the 
CLI to install a new upgrade license. (See the “Install-
ing an Upgrade License” section in the Wireless LAN 
Switch and Controller Installation and Basic Configu-
ration Guide.)

The WX4400 licensing change does not affect licens-
ing of 3WXM itself. (For information about the 
3WXM licensing, see “Licensing” on page 6.)

Even with a 120-MAP license installed, a WX4400 can 
support only 96 of the following MAP models, in any 
combination: AP7250, AP8250, and AP8750. The 
remaining 24 MAPs can be other models such as 
AP3750 and AP2750. 

Support for MSS Version 4.0 Enhancements

3WXM 4.0 supports configuration and management 
of the following MSS enhancements:

■ Support for external MAP antennas (added in MSS 
Version 4.0.21)

■ Support for 120 Active MAPs on a WX4400 
(added in MSS Version 4.0.21)

■ Support for new MAP Model AP3750

■ Remote WX configuration

■ DHCP client

■ Automatic configuration of Distributed MAPs

■ Authentication for third-party access point users

■ Security for management traffic between WX 
switches and Distributed MAPs

■ Rogue detection enhancements

■ Intrusion Detection System (IDS) and Denial of Ser-
vice (DoS) alerts

■ Portal WebAAA

■ Wi-Fi Multimedia (WMM) support

■ SNMPv2c and SNMPv3 support

■ Management Information Base (MIB) enhance-
ments

■ DHCP server

For more information about these features, see the 
Wireless LAN Switch and Controller MSS Version 4.0 
Release Notes and the Wireless LAN Switch and Con-
troller Installation and Basic Configuration Guide.

Remote Configuration of WX Switches

You can use 3WXM Services running in your corpo-
rate network to configure WX switches in remote 
offices. The following remote configuration scenarios 
are supported:
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■ Drop ship—3WXM Services running in the corpo-
rate network can configure a WXR100 switch 
shipped directly to a remote office. This option 
does not require any preconfiguration of the 
switch.

■ Staged—You can stage any model of switch by 
preconfiguring IP connectivity and enabling 
auto-config, then sending the switch to the 
remote office. The switch contacts 3WXM Services 
in the corporate network to complete its configu-
ration.

The network administrator at the corporate office 
preconfigures the switch in a 3WXM network plan. 
The switch configuration must have a name for the 
switch, the model must match the switch’s model, 
and the serial number must match the switch’s serial 
number. The configuration should also include all 
other settings required for the deployment, including 
MAP configuration, SSIDs, AAA settings, and so on. 

When the switch is powered on, if auto-config is 
enabled on the switch, the switch contacts 3WXM 
Services. 3WXM Services looks in the currently 
selected network plan for a WX configuration with 
the same serial number as the one in the configura-
tion request.

■ If the network plan contains a configuration with a 
matching serial number, 3WXM deploys the con-
figuration to the switch.

■ If the network plan does not have a configuration 
with a matching serial number, a verification warn-
ing appears in 3WXM. The warning lists the 
switch’s serial number and IP address. The network 

administrator can upload the switch into the net-
work plan, configure switch parameters, and 
deploy the configuration to the switch. 

For more information, see the following:

■ Wireless LAN Switch and Controller Quick Start 
Guide

■ “WX Setup Methods” chapter in the Wireless LAN 
Switch and Controller Installation and Basic Con-
figuration Guide

Network Plans Reside on the Server

In 3WXM versions earlier than Version 4.0, creation 
and management of network plans occurred in the 
client. In 3WXM Version 4.0, network plans are cre-
ated and managed using 3WXM Services (the server).

If 3WXM detects that there are network plans in the 
client directory (./xml/db), then it will present a dialog 
box asking what should be done with the old plans. 
You should copy the plans to the server unless they 
have already been copied to the server (for example, 
by another user). You can delete plans that you no 
longer require and do not want to copy to the server. 
3Com recommends that you archive the ./xml/db 
directory before you delete any plans.

To open an existing plan or create a new one, you first 
must connect to 3WXM Services. (For information, 
see the “Getting Started” chapter of the Wireless 
LAN Switch Manager Reference Manual.)
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WX Switches Are Not Required To Be in a Mobility 
Domain

In 3WXM versions earlier than Version 4.0, every net-
work plan contained a Default Mobility Domain. All 
new switches were placed in this Mobility Domain by 
default, and each switch had to be in a Mobility 
Domain, either the default one or one you created in 
the network plan. In 3WXM Version 4.0, there is no 
default Mobility Domain, and membership in a Mobil-
ity Domain is optional. In addition, the Organizer 
panel in Version 4.0 does not have a Mobility 
Domains area. Instead, Mobility Domains and individ-
ual WX switches appear in the Equipment area. If a 
switch belongs to a Mobility Domain, the switch is 
listed under (subordinate to) the Mobility Domain. 
Otherwise, the switch is listed at the same level as the 
Mobility Domains. 

Policies Can Be Configured and Applied for 
Individual Feature Areas

In 3WXM versions earlier than Version 4.0, each 
Mobility Domain contained a Domain Policies object. 
The Domain Policies object was a set of WX features 
that you could configure and then apply to switches 
in the plan, to configure those switches. Version 3.x 
did not allow you to individually configure or apply 
feature areas within a Domain Policy. If you applied a 
Domain Policy to a switch, all applicable parameter 
settings in the policy were applied to the switch(es). 

In 3WXM Version 4.0, the Organizer panel contains a 
new area, Policies, where you can configure multiple 
policies. Each policy has individually configurable fea-
ture areas. When you configure a policy, you select 

the feature areas you want to include in the policy. 
When you apply the policy to a switch, only the 
parameters in the selected feature areas are applied 
to the switch. (For more information, see the “Con-
figuring and Applying Policies” section in the “Man-
aging WX System Images and Configurations” 
chapter of the Wireless LAN Switch Manager Refer-
ence Manual.)

Online Help Is Accessible by Pressing F1

In 3WXM versions earlier than Version 4.0, the online 
help was not accessible when a wizard was open. In 
3WXM Version 4.0, you can access the help at any 
time by pressing F1. 

Version Compatibility
■ This version of 3WXM has been verified against 

MSS Version 4.0.21. 

■ Network plans created with 3WXM 3.x are com-
patible with this version of 3WXM. If you want to 
use network plans created with previous versions 
of 3WXM, make sure the option to delete the net-
work plans directory is not checked if you uninstall. 

After you install the new software, 3WXM asks 
whether the old network plans are to be sent to 
the server (if you want to keep them) or deleted. If 
multiple clients are using the same server, then the 
old network plans need to be copied only once. 
3Com recommends that you archive the ./xml/db 
directory before you delete any old plans.

■ You will require the appropriate licenses for each 
host on which you plan to install the 3WXM Client 
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and Services. If you are upgrading from 3WXM 3.x 
then you will have already installed the appropriate 
licenses. For more information, see “Licensing” on 
page 6.

■ If you are using 3WXM to update the image of a 
wireless switch from MSS 3.0 to 3.2 or from MSS 
3.2 to 4.0; then you must distribute the configura-
tion as well as the image to the wireless switch. 

CAUTION: A WX1200 running MSS Version 3.0 
MUST first be updated to MSS Version 3.2 before 
it can be successfully updated to MSS Version 4.0 
or later.

Supported Platform

Microsoft Windows Server 2003, Microsoft Windows 
XP with Service Pack 1 or higher, or Microsoft Win-
dows 2000 with Service Pack 4.

You must use the English version of the operating sys-
tem. Operating system versions in other languages 
are not supported with 3WXM.

Fixes for Known Faults in Version 4.0.15

Changing a switch's enable password in 3WXM 
caused status polling of the switch to stop until 
status polling was globally disabled and reenabled. 
(21886) 

A WX switch added to a network plan sometimes did 
not appear in Monitor windows. (22943)

Deleting a secondary Distributed MAP connection 
could cause an exception. (23281)

Fixes for Known Faults in Version 3.2.5

Using the Undo feature in the Local & Network 
Changes dialog box did not restore a WX to its 
original Mobility Domain. (12676)

Changes in the order of network or admin access 
rules were not displayed in Review Changes. (14191)

3WXM incorrectly reported Mobility Domain 
configuration changes after deleting and 
re-uploading a WX switch. (16044)

List of Distributed MAP changes for verification 
included incomplete form of deprecated command. 
(18695)

In the list of CLI commands 3WXM displayed for 
review before applying changes to a switch’s configu-
ration, one of the commands for configuring a Dis-
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tributed MAP, set dap num sticky-bit enable, was 
not displayed in its complete form. Instead, only set 
dap num was displayed. 

The set dap num sticky-bit is not supported in MSS 
Version 4.0 and no longer appears in any form in the 
list of changes for review.

Static IP routes created in a Domain Policy were not 
applied to WX switches. (18766)

A java NullPointerException could occur during 
backup of the database. (18989)

Deploying a configuration that had WPA enabled on 
a clear SSID caused the switch to lose its 
configuration. (19040)

Licensing
A licensed copy of 3WXM comes with a base license 
key, which is located inside the CD cover. To use 
3WXM, you need to enter the base key and an activa-
tion key, which you obtain from 3Com. The base key 
and activation key enable you to manage up to 10 
wireless LAN switches. To manage more than 10 wire-
less LAN switches, you also need an upgrade key and 
additional activation key, which you obtain from 
3Com.

If you are installing an evaluation copy, you still need 
to obtain an activation key from 3Com.

Each time you start 3WXM, it checks the license infor-
mation. If the product is not licensed, the following 
dialog is displayed.

1 If you are installing a licensed copy, select Standard 
Base Product and click Next. Go to step 2.

If you are installing an evaluation copy, select Time 
Limited Evaluation and click Next. Go to step 3.
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2 Type the license key that was supplied with the 
3WXM CD, and click Next. 

3 Click Get Activation Key. A 3Com web page 
appears. Enter your registration information (and 
the license key, if you are licensing a purchased 
copy) in order to obtain an activation key.

4 Copy the activation key from the web page and 
paste it into the Activation Key box of the Activa-
tion Key page. 

5 If you plan to manage 10 or fewer wireless LAN 
switches, click Finish. You are through with this pro-
cedure.

If you are activating an evaluation copy, you can 
manage up to 10 wireless LAN switches. Click Finish 
to complete this procedure.

If you plan to manage more than 10 wireless LAN 
switches, click Next to display the following page and 
go to step 6. 

6 Type the upgrade license key in the License Key box 
and click Next.

7 Click Get Activation Key to access the product acti-
vation key for your upgrade license. Register your 
upgrade license in order to obtain its activation key.

8 Copy the activation key for the upgrade license 
from the web page and paste it into the Activation 
Key box of the Activation Key page. 

9 Click Finish.

Upgrading from 3WXM Version 3.x
If you are upgrading from 3WXM Version 3.x and you 
have network plans created or saved in Version 3.x, 
3Com recommends that you archive the ./xml/db 
directory before you install the upgrade.

When you run 3WXM, if it detects that there are net-
work plans in the client directory (./xml/db), it displays 
a dialog box asking you what to do with the old 
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plans. You should select the option to copy the plans 
to the server unless they have already been copied to 
the server (for example, by another user). You can 
delete plans that you no longer require and do not 
want to copy to the server. 

To install the upgrade:

1 Make an archive copy of the ./xml/db directory. 

2 Install 3WXM.

3 When you run 3WXM it will ask you what to do with 
the old network plans.

■ If 3WXM Version 4.0 has already been installed on 
another client, and the option to copy the network 
plans to the server was selected, then do not select 
the option to copy the plans to the server. (See 
“Unable to switch network plans.” on page 15.)

Likewise, do not select the option to copy the 
plans to the server, if the plans have already been 
copied to the server manually.

■ If this is the first installation of 3WXM Version 4.0, 
then select the option to copy the plans to the 
server.

Downgrading to a Previous 3WXM Version

If you need to downgrade from a 3WXM 4.0.x ver-
sion to a previous 4.0.x version, use the following 
procedure:

1 Back up the network plans, by copying the config-db 
directory to a location that is not in the 3WXM instal-
lation path.

2 Back up the database, by copying the services-db 
directory to a location that is not in the 3WXM instal-
lation path.

3 Uninstall the current 3WXM installation. Select to 
delete all but the license.

4 Install the earlier 3WXM software version.

5 After installation, copy the folders in the backed up 
config-db directory to the one that is created by the 
installation in step 4.

6 After installation, copy the folders in the backed up 
services-db directory to the one that is created by the 
installation in step 4.

If you need to downgrade the WX switches managed 
by 3WXM, you can do so before or after the 3WXM 
downgrade.

3Com recommends that you do not downgrade to 
3WXM Version 3.x. Database files saved in 3WXM 
Version 4.0 cannot be used in 3WXM Version 3.x. In 
addition, MSS features that are new in MSS Version 
4.0 are not supported in previous versions of 3WXM.
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Submitting Problem Reports
You can generate a problem report at any time by 
selecting Help > Report Problem in 3WXM. 

To generate a problem report:

1 Do one of the following:

a In the Internal Application Error dialog box, click 
Report Problem.

b Select Help > Report Problem.

The Report Problem to 3Com dialog box appears.

2 Fill out the information in the dialog box.

Provide your name, and enter as much detail as possi-
ble about the task you were performing when the 

problem occurred. You must provide the name of 
your company.

3 Click Save to store the problem report on the 3WXM 
host. 

The problem report is saved as a directory with a 
name containing the timestamp of the problem 
report (for example, 
Thu-Aug-19-13-04-11-PDT-2004). This directory is 
located in C:\Documents and Set-
tings\user_home_directory\.3WXM\bugs, where 
user_home_directory is the home directory of the 
user that is running 3WXM at the time the problem 
report is generated. 

To send the problem report to 3Com Technical Sup-
port, create a zip archive of the problem report direc-
tory and send the archive as an attachment. For email 
information, see the “Obtaining Support for your 
Product” appendix in the Wireless LAN Switch Man-
ager Reference Manual. 

Known Problems

A non-administrative user cannot run 3WXM. 
(12155)

3WXM generates an exception if a user does not have 
administrative privileges on the 3WXM host. This 
issue involves the Java Virtual Machine (JVM) that is 
being used by 3WXM and should be resolved with a 
future release of JVM.

To use 3WXM, users must belong to a “Power Users” 
group or be added to the administrators group in the 
Windows operating system.
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Default RADIUS parameters are not used for 
configuring a specific RADIUS server. (12301)

In the CLI, RADIUS parameters are implicitly inherited 
from the default set of RADIUS parameters. In 
3WXM, a RADIUS server’s initial parameters are 
always set to the factory default, regardless of any 
changes made to the Default RADIUS Parameters 
Setup page.

Set all RADIUS server parameters directly. You can use 
a domain policy to configure all the RADIUS servers 
and server groups for all the WX switches in the 
Mobility Domain.

When the VLAN name is composed entirely of 
numbers in ACL VLAN mappings imported from the 
CLI, 3WXM assumes that the VLAN name is a VLAN 
ID. (12682)

A VLAN can be specified in the CLI by its VLAN ID or 
its VLAN name. When the CLI command is imported 
into 3WXM, the VLAN reference type is not apparent. 
If the VLAN reference is composed entirely of num-
bers, 3WXM assumes that the reference is a VLAN ID. 
Otherwise, 3WXM assumes that the reference is a 
VLAN name. 

Do not use VLAN names that consist entirely of num-
bers.

Importing of a floor plan in JPEG format might fail 
with a color conversion exception. (14612)

On rare occasion, importing a floor plan in JPEG 
format might fail with the following Java exception: 

sun.awt.image.ImageFormatException: Unsupported 
color conversion request. 

This exception occurs because of unusual color pal-
ette settings in the file.

Using a JPEG editing tool, manually remove all extra-
neous information possible to remove the problem-
atic color information. Alternatively, convert the JPEG 
file into a GIF file to import.

Size or location adjustments of shared coverage 
areas with identical dimensions might cause 
problems when you run Compute and Place. (14631)

When shared 802.11a and 802.11b/g coverage areas 
are created, one coverage area is directly placed on 
top of the other. If you resize or move one of the cov-
erage areas, the other coverage area is now a differ-
ent shape or in a different location. Running 
Compute and Place might not work.

Use the dimension toolbar icon to set the center and 
size of each coverage area to identically match each 
other.

When importing a CAD file (DWG/DXF), any lines 
with arrowheads will display incorrectly. (15906)

When importing DXF or DWG CAD files with lines 
that have line ends (arrows, dots, and so on) the 
objects get imported with huge arrows at the ends of 
the lines.

Use a CAD program to remove any arrowheaded 
lines, or modify the line’s properties to not display an 
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arrowhead. Alternatively, delete the line while in the 
Edit Content page of the Floor wizard in 3WXM.

3WXM reports that changes have occurred even 
when the changes cancel each other out, but does 
not list the changes. (16212, 20534)

If you make a configuration change to a WX switch 
and then reverse the change before synchronizing 
3WXM and the WX, 3WXM still reports that changes 
have occurred, but does not list any changes. For 
example, if you use the CLI to change the system 
description, then clear the change, the Local & Net-
work Changes dialog shows Configuration changes 
in the Local Status field for the WX. However, no 
changes are listed when you select Review.

This issue is cosmetic and does not affect the configu-
ration or operation of 3WXM or the switches.

3WXM does not support the Ctrl + drag-and-drop 
mouse operation. (16425)

Using characters that are not in the set of printable 
ASCII characters in the names or labels of image files 
in imported drawings could cause the files to 
become very large when saved, and could cause very 
slow performance of 3WXM. (17038, 18857)

If you have already imported a drawing that uses 
characters other than printable ASCII characters and 
you are experiencing either of these issues, contact 
3Com Technical Support for assistance. 

Polling interval for client session cannot be changed. 
(17585)

By default, 3WXM polls every 30 seconds for updates 
to information for clients on the watch list. In Version 
4.0, this polling interval cannot be modified.

Enabling STP on a WX switch's management VLAN 
causes a configuration deployment to fail. (17668)

If you use 3WXM to enable STP on a WX switch's 
management VLAN, then deploy the configuration, 
the deploy fails. The failure occurs because the man-
agement interface must pass through the standard 
Listening and Learning states, which together take at 
least 30 seconds, before the interface can change to 
the Forwarding state. Until the interface reaches the 
Forwarding state, the switch cannot receive traffic, 
such as configuration deployment from 3WXM, on its 
management interface.

If this occurs, wait 30 seconds for the interface to 
reach the Forwarding state, then accept the WX 
switch's change in 3WXM.

Changing the unit of measurement of a drawing 
requires rescaling the drawing. (17941)

If you change the unit of measurement for a floor 
plan, 3WXM does not rescale the drawing accord-
ingly. For example, if you change the unit of measure-
ment from feet to meters, a 1-foot distance becomes 
a 1-meter distance.

If you change the unit of measurement, use the ruler 
icon to adjust the scale of the floor plan.
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Childless objects in the Organizer panel have plus 
signs. (18188)

Objects in the Organizer panel that do not have sub-
objects (children objects) nonetheless display plus 
signs, which indicate that the object can be expanded 
to display the subobjects that it contains. However, 
when you click on the plus sign next to one of these 
objects to expand it, there are no children and the 
plus sign disappears.

This issue is cosmetic only and does not affect the 
operation of the product.

Disabled radio on operational MAP does not turn red 
if the MAP or WX switch becomes unavailable. 
(18330)

In the Explore and Status Summary windows of the 
Monitor tab, the operational state of the equipment 
is indicated by color, and is also indicated in the Status 
column of the Status Summary window. For example, 
if a WX switch goes down, its icon turns red. How-
ever, if the MAP or WX switch for a disabled radio 
goes down, the radio does not turn red. In addition, 
the value in the Status column of the Status Summary 
window changes from Operational to Not Applicable. 
(It is normal for a disabled radio’s state to be Opera-
tional, since disabled radios perform RF sweeps for 
rogue detection.)

This issue is cosmetic only and does not affect other 
information displayed for the equipment.

Daylight Savings Time or timezone changes are not 
automatically detected in 3WXM. (18422)

If a Daylight Savings Time or timezone change occurs 
on the host machine where 3WXM is running, dis-
played timestamps are not automatically updated in 
3WXM. 

This issue is actually a Java Virtual Machine (JVM) 
issue. The JVM does not detect date or time changes 
made at the OS level. See the following web page:

bugs.sun.com/bugdatabase/view_bug.do?bug_id=421
6582

Exit and restart 3WXM to place a date or time change 
made on the host machine that is running 3WXM 
into effect.

MAPs added to a coverage area do not immediately 
appear on the Objects to Place tab. (18680)

During planning, if you add MAPs to a coverage area, 
the MAPs appear in the upper left corner of the work-
space, but they do not appear on the Objects to Place 
tab. 

Click on the coverage area or select another wizard 
page, then reselect the Plan RF Coverage page. The 
MAPs appear on the Objects To Place tab.

Administrative names of MAPs can take a long time 
to be displayed in the RF Monitor window. (18838)

http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=4216582
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Java issue causes internal application error during 
import of configuration files. (19558)

If you attempt to import a configuration file, a known 
Java issue can cause an internal application error 
when you are using the file chooser to select the con-
figuration to import. For information, see the follow-
ing link:

bugs.sun.com/bugdatabase/view_bug.do?bug_id=506
1077

Use the upload option instead.

Default STP bridge priority for WX1200 is incorrect in 
3WXM. (19711)

In MSS Version 3.2, the default STP bridge priority for 
the WX1200 is changed from 32768 to 49152. The 
default is correct in MSS. However, 3WXM still has 
the old default. This mismatch can result in the fol-
lowing issues:

■ If you deploy a configuration from 3WXM to the 
WX1200, 3WXM changes the bridge priority back 
to 32768.

■ If you upload a WX1200 into 3WXM or synchro-
nize 3WXM with the network, the following verifi-
cation error appears:

VLAN number and STP number do not match 

To work around these issues, do the following:

■ Before deploying a configuration from 3WXM, 
change the STP bridge priority for the switch in 
3WXM to 49152.

■ After uploading a switch or synchronizing 
changes, change the STP bridge priority in 3WXM 
to 49152.

BSSID-SSID mappings are not correctly displayed for 
switches running MSS Version 3.2 or lower. (19968)

Default rogue location colors do not automatically 
take effect. (20235)

Rogue detection uses a default set of colors to indi-
cate a rogue’s location. However, these default colors 
are not implemented automatically. Instead, a rogue’s 
location is displayed as a grid of blue squares. This 
issue occurs only if rogue location color preferences 
have not been saved. 

To work around this issue, save a set of rogue detec-
tion color preferences. To save the default color set:

1 Select Tools > Preferences to open the Preferences 
dialog.

2 Select the RF tab, then select the Probability Colors 
tab.

3 Select any color, to display the Color chooser.

4 Select the same color and click OK.

http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=5061077
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The next time you use the rogue location feature, the 
default color set is used to indicate the rogue’s loca-
tion.

dbtools command line utility is not applicable to 
backing up or restoring network plans. (20416) 

3WXM 4.0 automatically saves backups of network 
plans, and enables you to configure backup options, 
create backups, and restore network plans from back-
ups. However, the network plan backups cannot be 
managed using the dbtools command line utility. 

To manage network plan backups, use the 
Backup/Restore dialog (Tools > 3WXM Services 
Backup/Restore).

Save is sometimes unavailable on the 3WXM 
Services setup page. (20549)

The Save button isn’t available until the focus on the 
Services setup window has been changed. This may 
be done by clicking a drop-down box or one of the 
up-down arrows on the window.

Finish button after a USM user is configured is 
unavailable until you click on another field. (20750)

After you configure the values for an SNMPv3 user 
(USM user), the Finish button in the dialog does not 
become available after you supply the final value. 

To activate the button, click on another field in the 
dialog. 

The Mobility Domain tree can expand in an 
unexpected manner. (20944)

The tree showing the switches in the Mobility Domain 
can expand in unexpected and confusing ways while 
editing switch properties. Always verify that you are 
editing parameters on the desired switch before com-
mitting your changes.

When a building name is changed, links are not 
updated in the work order. (20946)

If a Building is added to a site, and a work order is 
generated, and then the name of the building is 
changed and the work order is generated again, the 
work order will contain the old building name in the 
links at the top of the work order.

Deleting a switch from the Equipment list stops 
rogue detection and monitoring for all switches. 
(20970)

If you delete a switch from the Equipment list in the 
Organizer panel, 3WXM stops rogue detection and 
monitoring not only for the deleted switch, but for all 
switches managed by the network plan.

After deleting the unwanted switch, click Refresh to 
restart rogue detection or monitoring for the other 
switches. 

3WXM does not use countermeasures start and stop 
traps from WX switches. (21007)

The rogue detection information displayed by 3WXM 
does not include information from countermeasure 
start and stop traps sent by WX switches. 
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Monitor Tab stops showing Uptime, Serial Number, 
and software version information. (21014) 

The monitor tab in 3WXM will not always show the 
uptime, serial number and software version for the 
switches it is managing. This problem most often 
occurs shortly after 3WXM has been opened and 
before any changes have been uploaded to the 
switches.

Network Plans might be difficult to open in 3WXM. 
(21147) 

After closing a network plan, it occasionally might be 
difficult to open a saved network plan in 3WXM. In 
the Open Progress box, 3WXM will display a message 
that it is retrying the connection. The network plan 
will eventually open after the retry messages are seen.

The Events tab doesn’t always show the newest 
events to the user. (21167)

New events appear out of view on the Events tab. Use 
the page-down button on your keyboard, or scroll 
down using your mouse to continuously view the 
newest events.

A MAP whose model number is changed by 3WXM 
does not come up unless the switch is restarted. 
(21275)

Uptime gets stuck on the Monitor tab in 3WXM. 
(21298) 

Occasionally, the uptime display will stop updating on 
the Monitor tab, resulting in old information being 

displayed for the uptime of the switches being man-
aged by 3WXM.

Duplicate Mobility Profiles can be created. (22350) 

This can occur if you configure a Mobility Profile, use 
Policy Manager to apply the profile to switches, then 
deploy the changes to the network. The next time 
you make a change to the policy, the Mobility Profile 
appears in the change review list and is applied to the 
switches. The duplicate then appears in the Organizer 
panel under each of the switches. 

If this occurs, you can try to delete the duplicates 
from the Organizer panel. 

In some countries, certain channels cannot be set 
using 3WXM with external antennas. (23509)

The following channels cannot be set using 3WXM 
when using external antennas:

■ In Austria, channels 52 through 140

■ In Bulgaria, channels 60 and 64

■ In Cyprus and Slovakia, channels 100 through 140

To set these channels, use the command line interface 
(CLI) provided with MSS on the wireless switch.

Unable to switch network plans.

If you try to switch to a version 3 network plan that 
still exists on the local client, 3WXM displays a dialog 
box asking you what to do with the version 3 net-
work plans. The default is to send them to the server. 
However, this will fail if a copy already exists on the 
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server (for example, copied there by another user). If 
you cancel this dialog box, the network plan will not 
be switched.

After you copy the version 3 plans to the server, 
rename the ./xml/db directory to /xml/dbold. You can 
now switch to the copy of the network plan on the 
server.

Documentation Errata

Remote configuration of a switch by 3WXM requires 
the network plan to be saved on the server first. 
(20712)

If you use the remote configuration option to config-
ure a WX switch, you must save the network plan 
that contains the switch’s configuration, before the 
switch contacts 3WXM Services. Otherwise, 3WXM 
will not be able to configure the switch.

Do Not Specify an Enable Password for a Prestaged 
WXR100. 

If you are configuring a WXR100 switch in 3WXM 
and the switch is drop-shipped (not pre-staged), do 
not specify an enable password in the switch’s config-
uration in 3WXM. If you do, 3WXM will not be able 
to communicate with the switch to configure it, 
because the default enable password is blank (not 
set).

Monitoring of a new switch does not begin until the 
network plan is saved. (21034)

To initiate monitoring of a switch, you must save the 
network plan after the switch is added to the plan. 
Until the plan is saved, the switch’s status is unknown.

Clarification on the different 3WXM user levels.

3WXM users can log on to 3WXM at one of three dif-
ferent access levels. Here is a summary of the levels 
and the specific access they provide:

■ Administrator—All options and tabs are available.

■ Provision—3WXM Services setup options and tabs 
(accessed via Tools > 3WXM Services Setup) are 
not available. All other options and tabs are avail-
able. 

■ Monitor—

■ On the Tools menu, the 3WXM Services setup 
options are greyed out, and the Certificate 
Management and Image Repository options are 
not present. 

■ On the File menu, the options used to manage 
network plans (Export, Import, Switch, and 
Delete) are greyed out, and the Upload option is 
not available. 

■ All fields related to 3WXM Services are greyed 
out.

■ Tabs to deploy and undo local changes and 
accept or undo network changes are not avail-
able.

■ The right-click menu in the Organizer panel has 
only the View option.
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■ Configuration items that are related specifically 
to monitoring (logs, managed devices, site sur-
veys and work orders) can be configured. How-
ever, new network plans cannot be configured.

The Verification panel allows you to edit switch con-
figuration items in order to resolve verification errors 
and warnings. However, you cannot save these 
changes in Monitor mode.

Clarification on assigning an orphan MAP to WX 
switches. (20989)

If 3WXM detects an orphan MAP in the network, a 
network verification error appears. If you use the link 
to fix the error, 3WXM adds the MAP as a Distributed 
MAP to all WX switches in the network plan. This 
solution ensures that the MAP can boot even if a 
switch is unavailable. 

If you do not want the MAP to be added to all 
switches, complete the solution provided by the link 
on the Verification tab, then remove the MAP from 
the individual switches on which you do not want the 
MAP to be configured.

Configuring WX switches to use 3WXM Services as 
an SNMPv3 notification target. (20926)

3WXM uses the Westhawk SNMP stack. If you plan to 
use SNMPv3 on WX switches and you want to use 
3WXM Services as an SNMPv3 notification target 
(trap receiver), you must use the following configura-
tion settings on the WX switches:

■ Set the target IP address to the IP address of 
3WXM Services.

■ Configure a user security model (USM) user with 
the following settings:

■ Engine ID local

■ Authentication protocol SHA or MD5, with a 
passphrase (instead of a key)

■ Encryption protocol DES, with a passphrase 
(instead of a key)

■ Enable traps in the default notification profile, or 
create a new profile and enable traps.

■ Configure a notification target that uses the IP 
address of 3WXM Services as its destination, uses 
the new notification profile, and specifies the USM 
user as the notification profile’s user. 

To configure SNMPv3 on a WX switch: 

1 Open the configuration wizard for the WX switch, 
then select SNMP under Management Services in the 
organizer list of the System and Administrative page.

2 Enable SNMPv3:

a Select Enabled to enable SNMP service on the WX.

b Select a security level from the Security Level 
pull-down list. By default, SNMP is unsecured.

c Select USM as the SNMP version.

3 Create an SNMPv3 user:

a In the organizer list of the System and Administra-
tive page, select New USM User.

b In the Username box, type the name of the 
SNMPv3 user. 

c Select notify-only as the access type. 
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d Specify LocalID for the Engine ID.

e Select the MD5 or SHA for the authentication type.

f Select passphrase as the authentication format, 
and type the value in the Password box. Type a 
string at least 8 characters long.

g Select DES as the encryption type.

h Select passphrase as the encryption format, and 
type the value in the Password box. Type a string at 
least 8 characters long.

i Click Finish to save the changes.

4 Create a notification profile:

a In the organizer list of the System and Administra-
tive page, select New Notification Profile.

b In the Profile Name box, type the name of the noti-
fication profile. 

c Click the Enable checkbox at the top of the list to 
enable all notification types.

d Click Finish to save the changes.

5 Configure a notification target (which in this case is 
3WXM Services):

a In the organizer list of the System and Administra-
tive page, select New Notification Target.

b Specify a number from 1 to 10 for the target ID. 

c Type the IP address of the target. (In this case, the 
IP address of the host on which 3WXM Services is 
installed.)

d Specify the protocol port on which the target lis-
tens for SNMP notifications. The default is 162. 

(This value must match the value in 3WXM Ser-
vices.) 

e Select the notification profile you created in step 4.

f From the Security Model pull-down list, select USM 
(SNMPv3).

g Select the security level:

■ Unsecured—SNMP message exchanges are not 
secure. 

■ Authenticated—SNMP message exchanges 
are authenticated but are not encrypted. (This 
security level is the same as the authNoPriv level 
described in SNMPv3 RFCs.)

■ Encrypted—SNMP message exchanges are 
authenticated and encrypted. (This security level 
is the same as the authPriv level described in 
SNMPv3 RFCs.)

h Select Trap as the notification type.

i Select the USM user you created in step 3.

j Click Finish to save the changes.

6 Repeat step 1 to step 5 for each WX switch. 

7 When you finish configuring SNMP on all the 
switches:

a Select File > Save to save the network plan. When 
the save progress messages indicate that the plan 
save is ok, click Finish.

b Select Manage > Deploy to deploy the configura-
tion changes to the network. Select the switches, 
then click Deploy.
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To configure 3WXM Services as an SNMPv3 notifica-
tion target:

1 Select Tools > 3WXM Services Setup. The 3WXM 
Services Setup dialog box appears.

2 Select SNMP V3 traps and click Save.

3 Click Close.

Clarifications about the Layout Cleanup option. 
(22156)

The Clean Layout option does not do anything with 
objects that are grouped. Also, the option does not 
clean up objects that are on separate layers. For 
example, if two parallel lines are close enough to be 
cleaned up, but each line is on a separate layer, the 
lines will not be cleaned up.

Clarification on enabling shared-key authentication. 
(23882, 24484)

Shared-key authentication is supported only for 
encrypted SSIDs. In addition, if you enable shared-key 
authentication, RSN, WPA, TKIP, and CCMP must be 
disabled. By default, RSN, WPA, and CCMP are 
already disabled, but TKIP is enabled; you must manu-
ally disable TKIP. (TKIP is not automatically disabled 
when WPA is disabled.) 

Copyright © 2006, 3Com Corporation. All rights reserved.
Unless otherwise indicated, 3Com registered trademarks are registered in the 
United States and may or may not be registered in other countries.

3Com is a registered trademark of 3Com Corporation. The 3Com logo is a 
trademark of 3Com Corporation. 

Mobility Domain, Mobility Point, Mobility Profile, Mobility System, Mobility System 
Software, MP, MSS, and SentrySweep are trademarks of Trapeze Networks, Inc.

Intel and Pentium are registered trademarks of Intel Corporation. Microsoft, 
MS-DOS, Windows, Windows XP, and Windows NT are registered trademarks of 
Microsoft Corporation. 

All other company and product names may be trademarks of the respective 
companies with which they are associated.



20 WIRELESS LAN SWITCH MANAGER (3WXM) VERSION 4.0.18 RELEASE NOTES


	Wireless LAN Switch Manager (3WXM) Version 4.0.18 Release Notes
	Related Documentation
	Software License Agreement
	What's New in 3WXM Version 4.0.18
	Support for External Map Antennas
	Support for 120 Active MAPs on a WX4400
	Support for MSS Version 4.0 Enhancements
	Remote Configuration of WX Switches
	Network Plans Reside on the Server
	WX Switches Are Not Required To Be in a Mobility Domain
	Policies Can Be Configured and Applied for Individual Feature Areas
	Online Help Is Accessible by Pressing F1

	Version Compatibility
	Supported Platform
	Fixes for Known Faults in Version 4.0.15
	Changing a switch's enable password in 3WXM caused status polling of the switch to stop until status polling was globally disabled and reenabled. (21886)
	A WX switch added to a network plan sometimes did not appear in Monitor windows. (22943)
	Deleting a secondary Distributed MAP connection could cause an exception. (23281)

	Fixes for Known Faults in Version 3.2.5
	Using the Undo feature in the Local & Network Changes dialog box did not restore a WX to its original Mobility Domain. (12676)
	Changes in the order of network or admin access rules were not displayed in Review Changes. (14191)
	3WXM incorrectly reported Mobility Domain configuration changes after deleting and re-uploading a WX switch. (16044)
	List of Distributed MAP changes for verification included incomplete form of deprecated command. (18695)
	Static IP routes created in a Domain Policy were not applied to WX switches. (18766)
	A java NullPointerException could occur during backup of the database. (18989)
	Deploying a configuration that had WPA enabled on a clear SSID caused the switch to lose its configuration. (19040)

	Licensing
	Upgrading from 3WXM Version 3.x
	Downgrading to a Previous 3WXM Version

	Submitting Problem Reports
	Known Problems
	A non-administrative user cannot run 3WXM. (12155)
	Default RADIUS parameters are not used for configuring a specific RADIUS server. (12301)
	When the VLAN name is composed entirely of numbers in ACL VLAN mappings imported from the CLI, 3WXM assumes that the VLAN name is a VLAN ID. (12682)
	Importing of a floor plan in JPEG format might fail with a color conversion exception. (14612)
	Size or location adjustments of shared coverage areas with identical dimensions might cause problems when you run Compute and Place. (14631)
	When importing a CAD file (DWG/DXF), any lines with arrowheads will display incorrectly. (15906)
	3WXM reports that changes have occurred even when the changes cancel each other out, but does not list the changes. (16212, 20534)
	3WXM does not support the Ctrl + drag-and-drop mouse operation. (16425)
	Using characters that are not in the set of printable ASCII characters in the names or labels of image files in imported drawings could cause the files to become very large when saved, and could cause very slow performance of 3WXM. (17038, 18857)
	Polling interval for client session cannot be changed. (17585)
	Enabling STP on a WX switch's management VLAN causes a configuration deployment to fail. (17668)
	Changing the unit of measurement of a drawing requires rescaling the drawing. (17941)
	Childless objects in the Organizer panel have plus signs. (18188)
	Disabled radio on operational MAP does not turn red if the MAP or WX switch becomes unavailable. (18330)
	Daylight Savings Time or timezone changes are not automatically detected in 3WXM. (18422)
	MAPs added to a coverage area do not immediately appear on the Objects to Place tab. (18680)
	Administrative names of MAPs can take a long time to be displayed in the RF Monitor window. (18838)
	Java issue causes internal application error during import of configuration files. (19558)
	Default STP bridge priority for WX1200 is incorrect in 3WXM. (19711)
	BSSID-SSID mappings are not correctly displayed for switches running MSS Version 3.2 or lower. (19968)
	Default rogue location colors do not automatically take effect. (20235)
	dbtools command line utility is not applicable to backing up or restoring network plans. (20416)
	Save is sometimes unavailable on the 3WXM Services setup page. (20549)
	Finish button after a USM user is configured is unavailable until you click on another field. (20750)
	The Mobility Domain tree can expand in an unexpected manner. (20944)
	When a building name is changed, links are not updated in the work order. (20946)
	Deleting a switch from the Equipment list stops rogue detection and monitoring for all switches. (20970)
	3WXM does not use countermeasures start and stop traps from WX switches. (21007)
	Monitor Tab stops showing Uptime, Serial Number, and software version information. (21014)
	Network Plans might be difficult to open in 3WXM. (21147)
	The Events tab doesn’t always show the newest events to the user. (21167)
	A MAP whose model number is changed by 3WXM does not come up unless the switch is restarted. (21275)
	Uptime gets stuck on the Monitor tab in 3WXM. (21298)
	Duplicate Mobility Profiles can be created. (22350)
	In some countries, certain channels cannot be set using 3WXM with external antennas. (23509)
	Unable to switch network plans.

	Documentation Errata
	Remote configuration of a switch by 3WXM requires the network plan to be saved on the server first. (20712)
	Do Not Specify an Enable Password for a Prestaged WXR100.
	Monitoring of a new switch does not begin until the network plan is saved. (21034)
	Clarification on the different 3WXM user levels.
	Clarification on assigning an orphan MAP to WX switches. (20989)
	Configuring WX switches to use 3WXM Services as an SNMPv3 notification target. (20926)
	Clarifications about the Layout Cleanup option. (22156)
	Clarification on enabling shared-key authentication. (23882, 24484)



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


